
 

 

Version 15.0.01 Release Notes 
This document lists the new features that have been introduced, and the issues that have been 
addressed, in the Powerproject version 15.0.01 release. 

Issue N/A Enterprise-specific  BIM-specific  

Summary Display tasks in a calendar view. 

Description You can now display the tasks in your projects in a calendar view. Calendar views 
display the tasks in one or more charts or summary groups in a calendar, or diary 
format, displaying whichever tasks appear in a project within a particular time 
period – a week or a month, for example. Calendar views can also be used to display 
the allocations that appear within a particular time period for specific resources or 
cost centres. Each project contains a default calendar view, and you can create as 
many additional calendar views as you like. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Check the quality of your schedules. 

Description You can now use schedule quality checks to identify whether a project has been 
planned well. A schedule quality check contains a set of user-definable quality 
metrics that you can use to monitor the quality of a schedule. You can choose which 
quality metrics to include in each quality check, and for each metric you can define 
what constitutes a pass or a fail – with the exception of a few metrics which result in 
a simple pass or fail. For example, you could include the Missing link logic metric, 
which checks for tasks with no incoming or outgoing links, and specify that the 
schedule should pass if 95% of tasks or more are linked and that it should fail if less 
than 85% of tasks are linked. If the proportion of unlinked tasks falls between the 
two percentages, a warning is reported. A schedule quality check can include a 
single quality metric, or any number of them. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Open views using the scope of the active view. 

Description Before this release, when you opened a different view, the view always opened with 
the Programme chart as its scope. You can now choose to open views using the 
scope of the current active view. If you do this, the view opens displaying whichever 
charts or summary groups provide the scope of the current active view. If you are 
currently viewing an RBS or CBS view and choose to open a different view, the view 
opens displaying whichever resources or cost centres provide the scope of the 
current active RBS or CBS view. 

To open a view using the scope of the current active view, select the Open using the 
active view scope check box that has been added to the More Views dialog, or hold 
down CTRL when selecting a view to open from the View dropdown on the Home or 
View tab of the Ribbon. 
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Issue N/A Enterprise-specific  BIM-specific  

Summary Display the codes from more than one code library on the bar chart at the same 
time. 

Description Before this release, you could display only the codes from a single library on the bar 
chart at any one time. Some users wanted to display the codes from more than one 
code library at the same time, and to get around this restriction, some users created 
all of their codes in a single code library, which could be difficult to maintain. 

Now, this restriction has been lifted: you can display the codes from more than one 
code library on the bar chart at the same time. You specify which code libraries to 
use to colour tasks either by right-clicking code libraries in the project view and 
selecting Display Library from the menu that appears, or by clicking the Display 
Libraries button, on the Tasks tab of the Format Bar Chart dialog. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Improvements to booking data in and out 

Description This release introduces a completely new way of booking data into and out of 
projects for remote editing. This functionality has been completely rewritten for this 
release to simplify and improve the booking in and out of data. In brief, the 
improvements comprise the following: 

• You now book out data by selecting one or more charts or summary 
groups, rather than by “tagging” individual objects. 

• Booked out charts and summary groups can be identified by a new icon 
that is applied to them in the project view. 

• The different book out statuses (read-only, read-write and read-write-
delete) have been removed; once a chart or summary group has been 
booked out, it is now always editable in the destination project and always 
read-only in the master project. As part of this change, the ‘Book from 
master status’, ‘Bookout tag’ and ‘Significant bookout status’ fields have 
been removed. 

• You can now specify whether users can book out charts and summary 
groups on a chart-by-chart basis, using the new Book out check box that 
has been added to the Chart Access Rights tab of the Security Group 
Properties dialog. 

• You can now specify whether users can cancel book outs that have been 
performed by users other than themselves, using the new Cancel book out 
check box that has been added to the General tab of the Security Group 
Properties dialog. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Apply different shapes to milestones. 

Description Before this release, milestones were limited to a single shape. Now, you can apply a 
wide range of shapes to milestones from the new milestone appearance library that 
has been added to Library Explorer. You may want to apply different shapes to 
milestones to differentiate between Start and Finish milestones, or between 
milestones that represent different types of event. 
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Issue N/A Enterprise-specific  BIM-specific  

Summary Import from and export to Primavera P6 in XML format. 

Description Before this release, you could import projects from, and export projects to, 
Primavera P6® in XER format. In addition to this, you can now choose to import and 
export in XML format. This has a number of advantages, the main one being that 
when you import and export in XML format, any baselines are included in the import 
or export. 

You now import from and export to Primavera software using commands on the 
new Import/Export tab that has been added to the Backstage view. This tab brings 
together the commands that enable you to import and export in a number of 
formats. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Import XER files for use as baselines. 

Description You can now import files that have been saved in Primavera XER format as 
baselines. If you import an XER file as a baseline, you do not specify how to map 
tasks in the XER file with tasks in the active project; tasks are always mapped using 
unique task IDs in this situation. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Baselines are now embedded automatically into projects. 

Description Before the release of version 15.0.01, baselines of local projects – as opposed to 
Powerproject Enterprise projects – were separate files, with a .PPB file extension. 
From version 15.0.01 onwards, any new baselines that you create for local projects 
are embedded automatically into the corresponding project file. For this reason, you 
are no longer asked to specify a location and file name for new baselines when you 
create them. 

Although you can continue to work with any existing separate baselines as you did 
before, you may want to embed them into the corresponding project. Embedding 
baselines into their corresponding projects makes it easier to share projects with 
other Powerproject users, as you do not have to provide both the project file and 
the baseline file(s); you need only to make the project file available, as it contains 
both the project and its baselines. If you save a copy of a project using the version 
15 file format, any embedded baselines will be saved with the file and will be 
available in the copy of the file. 

If you are working with a baseline that is embedded into a local project, or a 
baseline in a Powerproject Enterprise project, you can now export the baseline to a 
separate file. You may want to do this to make a baseline available to someone else 
without providing them with the project itself, or to save a copy of a baseline for 
reference purposes before deleting it from a project. 

Baselines of Powerproject Enterprise projects are stored in data sources and 
baselines of Powerproject Vision projects always exist as separate files; you cannot 
embed these types of baselines. 
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Issue N/A Enterprise-specific  BIM-specific  

Summary Baselines imported into Powerproject Enterprise projects are now stored in the 
project’s data source. 

Description If you import a project for use as a baseline in a Powerproject Enterprise project, the 
imported data is now stored in the same data source as the project. Before this 
release, file you imported remained as a separate file and links to the file were 
added to the Powerproject Enterprise project. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Specify how to match tasks in the file you are importing with tasks in the live project 
when importing a project or baseline. 

Description When you import a project or baseline, you can now specify how to map tasks in the 
project or baseline that you are importing with tasks in the active project. 
Powerproject needs to do this so that it knows which tasks in the file you are 
importing correspond with which tasks in the active project. Previously, 
Powerproject always mapped tasks using internal object IDs – the ID that is assigned 
to each object automatically by Powerproject when the object is created. You can 
now choose to use unique task IDs as an alternative, which you may want to do if 
you use unique task IDs to identify objects in your projects. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Select objects in the bar chart using an area select tool. 

Description You can now select multiple objects in the bar chart using an area select tool that 
has been added to the Home tab, in the Editing group. Using the area select tool, 
you click and drag an area in the bar chart and everything within the drawn area – 
tasks, allocations and links – is selected. This may be useful if you want to copy and 
paste a number of tasks, or if you want to select a number of tasks before applying 
the same code, resource or library object to them. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Chase link logic through a project. 

Description You can now use the properties view and the Bar and Task Properties dialog to 
follow, “trace” or “chase” link logic in a project, moving along the various paths of 
linked predecessor and successor tasks, with the bar chart view updating itself 
automatically as you move from one link to another and with the path you are 
chasing highlighted. To enable this, the Predecessors and Successors tabs of the 
properties view have been replaced by a single Links tab, containing two grids: the 
one on the left displaying information about links coming into the selected bar or 
task, and the one on the right displaying information about links coming out of the 
selected bar or task. 
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Issue N/A Enterprise-specific  BIM-specific  

Summary Specify more than one name or ID when creating or moving links using the Link 
From/To dialog. 

Description Before this release, when creating or moving links using the Link From/To dialog, 
you could specify only one name or ID at a time when specifying the tasks from or to 
which links should be drawn. You can now specify more than one name or ID on this 
dialog, resulting in links being drawn from or to tasks with any of the specified 
names. In the simple version of the dialog, you can specify multiple names and IDs in 
the Name and Unique task ID fields; in the complex version of the dialog, you can 
specify multiple names and IDs in the Bar name, Unique task ID, WBS code, Task ID 
(WBN) and Task name fields. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Use colour themes to apply the same colour to all elements of links when editing 
link categories. 

Description Before this release, if you wanted to set up a link category that used the same 
colour for the lines and arrowheads in all link styles, you had to configure the line 
colour and arrow colour for each link style individually. You can now apply a colour 
theme to link categories, which applies the selected colour to all elements of each 
one of a link category’s link styles, using the new Colour theme field that has been 
added to the Link Category Properties dialog. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Display summary tasks and expanded tasks as non-critical even if they are on the 
critical path. 

Description You can now display summary tasks and expanded tasks as non-critical even if they 
are on the critical path following a reschedule, using the Summary/Expanded tasks 
– Show as non-critical field that has been added to the Schedule tab of the Format 
Bar Chart dialog. 
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Issue N/A Enterprise-specific  BIM-specific  

Summary New Original start and Original finish fields. 

Description Original start and Original finish fields have been added to the Progress group of 
fields. You can display these new fields in the spreadsheet and in text annotations. 
The Original start and Original finish fields are kept in step with the start and finish 
date of tasks, until a task is started, at which point they are fixed at the start and 
finish date of the task immediately before progress was entered. Once a task is in 
progress or completed, you can edit these fields in the spreadsheet if required. 

These fields are calculated for summary tasks, expanded tasks and hammocks, with 
the Original start field displaying the earliest original start date within the parent 
task or hammock and the Original finish field displaying the latest original finish 
date. These fields are not editable for summary tasks, expanded tasks and 
hammocks. 

The Original duration field is now calculated as the duration between the original 
start and the original finish date of a task and is no longer editable. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Search for bars and tasks according to information in their user-defined fields. 

Description You can now search for information in string-type user-defined fields that have been 
created for use with bars, tasks and milestones. Each string-type user-defined field 
that has been created for these object types now appears in the Look in field, on the 
Find dialog. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Specify a delivery date against projects and use this as a deadline when rescheduling 

Description You can now specify a delivery date for projects, which may be useful if the contract 
for a project specifies a date by which the project must be completed. 

You can specify a delivery date for the programme of projects, and a delivery date 
for each chart or summary group that has been identified as being a project. You 
can use a project’s delivery date as a deadline when rescheduling. If you do this, 
rather than using the finish date of the last task in the project, the project’s late and 
free finish dates are set to the delivery date when rescheduling and float is 
calculated out to the project’s delivery date. A delivery date provides a deadline for 
all tasks in the project, so any tasks that exceed the delivery date have negative float 
(ie they become super-critical) following a reschedule. 

Setting a delivery date for a project is similar to setting a deadline flag on the 
project, apart from the fact that when you set a deadline flag, float is not calculated 
out to the flag's date when rescheduling. 
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Issue N/A Enterprise-specific  BIM-specific  

Summary Filter for tasks with a particular amount of slip. 

Description You can now filter for tasks that have a particular amount of slip, using the new Slip 
page that has been added to the Filter Wizard. This can help you to identify tasks 
which are very far behind schedule or very far ahead of schedule. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Filter for tasks that should have started by a certain date. 

Description You can now filter for tasks that should have started by a certain date, using the 
new Late Starting page that has been added to the Filter Wizard. A task is 
considered to be late starting if it was scheduled to start before a given date in a 
baseline, but starts after that date in the live project. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Filter for tasks with links of a particular type. 

Description You can now filter for tasks with incoming or outgoing links of one or more 
particular link types, using the new Search for links based on link type fields that 
have been added to the Links page of the Filter Wizard. For example, you may want 
to filter for tasks with Start-to-Start links. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Filter for tasks with links that have lead/lag. 

Description You can now filter for tasks with incoming or outgoing links that have lead/lag – any 
amount of lead/lag, or a particular amount of lead/lag – using the new Search for 
links with lead/lag fields that have been added to the Links page of the Filter 
Wizard. For example, you may want to filter for tasks with links that have more than 
2d lead/lag, or less than 1w lead/lag. 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary International currency code now stored against currency units. 

Description A Short name field has been added to the Currency Unit Properties dialog, to store 
the international currency code for each currency unit, for example GBP, EUR, USD 
or AUD. This information is now transferred to and from Primavera software 
projects when you import and export projects in XER or XML format. 

When you upgrade an existing project to version 15.0.01, the international currency 
code is entered into this field automatically for each currency unit. 
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Issue N/A Enterprise-specific  BIM-specific  

Summary Enter dated notes against tasks, and link documents and webpages to tasks. 

Description As well as being able to enter textual notes against tasks, you can now also enter 
three types of dated note against tasks. These are notes against which the date and 
time of each note are recorded. The following types of dated note are available: 

• Text notes. 
• File notes – these are hyperlinks which can be clicked to open a particular 

file. Use these notes to attach relevant documents or photographs to tasks. 
• URL notes – these are hyperlinks which can be clicked to open a particular 

webpage. Use these notes to link relevant webpages to tasks. 

If you use Site Progress Mobile to record progress against tasks and build stages in 
Powerproject projects using a mobile device, any notes that have been recorded 
against tasks by mobile users, as well as any photographs they have taken, appear 
against tasks as dated notes 

 

Issue N/A Enterprise-specific  BIM-specific  

Summary Specify new build behaviours and a build direction when setting up IFC simulation 
profiles. 

Description If you use IFC simulation profiles to control the appearance of objects during 
timeline simulations, you can now choose from two new build behaviours when 
setting up an IFC simulation profile, using the Build behaviour field on the IFC 
Simulation Profile Properties dialog: 

• Construction – select this to specify that objects should be visibly “built”, or 
“constructed”, at the start of the tasks with which they are associated and 
that they should remain visible from then on. This would be a suitable build 
behaviour for an object such as a brick wall that is built gradually, rather 
than being installed in one piece. 

• Destruction – select this to specify that objects should be visible before and 
during the tasks with which they are associated and that they should be 
visibly “deconstructed”, or “destroyed” at the finish of the tasks. This 
would be a suitable build behaviour for an object such as a brick wall that is 
destroyed gradually, rather than being removed in one piece. 

If you select one of these build behaviours, you can specify the direction in which 
objects are either “constructed” or “destroyed”, using the new Direction field on 
the IFC Simulation Profile Properties dialog. 
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Issue 5124 Enterprise-specific  BIM-specific  

Summary Print legends on pages other than the last in printouts. 

Description A request was made for it to be possible to specify the pages on which legends 
appear in printouts. 

Resolution New fields have been added to the Appearance tab of the Print dialog that you can 
use to specify where to print legends: at the bottom of the printout, at the bottom 
of each page, or at the bottom of each page that includes an item that is included in 
a legend. 

 

Issue 25869 Enterprise-specific  BIM-specific  

Summary Completed tasks incorrectly displayed as critical. 

Description A customer reported that if the Show nearly critical tasks as critical check box on 
the Schedule tab of the Format Bar Chart dialog was selected and the Split 
progressed sections check box on the Progress tab of this dialog was cleared, 
completed tasks were incorrectly displayed as critical. 

Resolution Powerproject was incorrectly marking completed tasks as critical when the Show 
nearly critical tasks as critical check box was selected as it was assumed that all 
tasks with no total float should be displayed as critical – and completed tasks have 
no total float. Powerproject no longer marks completed tasks as critical. 

 

Issue 25907/28881 Enterprise-specific  BIM-specific  

Summary Incorrect task work amount is displayed in the spreadsheet. 

Description Before this release, customers reported that task work amounts were sometimes 
displayed incorrectly in the spreadsheet. In one instance, task work amount was 
being displayed as 86.59 in the spreadsheet when it should have been displayed as 
86.6, and it was not possible to correct the task work amount in the spreadsheet to 
86.6. 

Resolution This issue was caused by the way in which Powerproject stored floating point 
numbers. Powerproject now stores these numbers in a more accurate way, which 
has resolved the problem. 

 

Issue 26113 Enterprise-specific  BIM-specific  

Summary Group sorted views by day, week, month, quarter and year. 

Description A request was made for it to be possible to group the tasks in a project by start date 
and interval – for example by day, week, month, quarter and year. 

Resolution You can now group the tasks in a project by day, week, month, quarter and year, 
using the Group by field that has been added to each tab of the Sort/Group 
Properties dialog. 
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Issue 27035 Enterprise-specific  BIM-specific  

Summary Produce project analysis reports in .CSV format. 

Description A request was made for it to be possible to use Project Comparison to produce 
project analysis reports in .CSV format. 

Resolution You can now produce project analysis reports in .CSV format. 

 

Issue 28322 Enterprise-specific  BIM-specific  

Summary Display an indicator in the spreadsheet to identify the status of tasks. 

Description Add an indicator to the spreadsheet, to identify the status of the tasks on each bar. 

Resolution You can now display an indicator in the spreadsheet to identify the status of tasks, 
using the Display status indicators in the spreadsheet check box that has been 
added to the View tab of the Options dialog. When this check box is selected, the 
indicator appears in the left side of the Bar name, Task name and Name columns in 
the spreadsheet. It shows: 

• Red for critical tasks that have not yet started. 
• Blue and red for critical tasks that have started. 
• Green for non-critical tasks that have not yet started. 
• Blue and green for non-critical tasks that have started. 
• Blue for tasks that are complete. 

The indicator identifies the status of the visible tasks on the bar; it ignores any tasks 
that are not currently visible, for example those that do not meet the criteria of a 
filter that has been applied. 

For bars that contain more than one task, the indicator displays red if one or more 
tasks are critical; otherwise, it displays a colour appropriate to the mix of tasks. For 
example, if a bar contains a mixture of started non-critical tasks and completed 
tasks, the indicator displays blue and green. 

 

Issue 28617 Enterprise-specific  BIM-specific  

Summary Specify the appearance of the Selected and Critical link categories. 

Description Before this release, the only appearance attribute that you could specify for the 
Selected and Critical link categories was the colour. A request was made for it to be 
possible to specify all appearance attributes for these link categories. 

Resolution Now, all of the fields on the Link Category Properties dialog are available for these 
two link categories. This means that if you wanted to, you could specify that critical 
links appear with a thick, dotted style; or that selected links appear with a blue, 
dashed style. As part of this change, the Selected link colour and Critical link colour 
fields have been removed from the Link Category Properties dialog, as these fields 
are no longer required. 
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Issue 29178 Enterprise-specific  BIM-specific  

Summary Choose where to display the progress line on bars with out of sequence progress. 

Description Before this release, if you displayed jagged progress lines on the bar chart, they 
were always drawn at the progress period report date on bars containing tasks with 
out of sequence progress. A request was made for it to be possible to display 
progress lines on such bars at the start of the first uncompleted section. 

Resolution You can now choose to display progress lines on bars containing tasks with out of 
sequence progress at the start of the first uncompleted section, by selecting the Use 
first out of sequence section check box that has been added to the Progress tab of 
the Format Bar Chart dialog. 

 

Issue 29256/29702/29777 Enterprise-specific  BIM-specific  

Summary Pre-populate progress rejection emails with information on approved and rejected 
progress. 

Description When approving or rejecting progress that has been recorded remotely using Site 
Progress Mobile, you can email Mobile users with information on why you are 
rejecting the progress they have entered, or to request additional information. 
Before this release, these emails contained no information on the progress that the 
user had recorded, so you had to enter this information manually into each email. A 
request was made for the emails to be pre-populated with information on approved 
and rejected progress. 

Resolution Now, progress rejection emails are pre-populated with information on the user’s 
tasks that you have approved and rejected, which saves you from having to enter 
this information manually. You can add other information to each email as required. 

 

Issue 29257 Enterprise-specific  BIM-specific  

Summary Overwrite progress information that has been recorded by Site Progress Mobile 
users before it is applied to projects. 

Description A request was made for it to be possible to overwrite progress information that has 
been recorded by Site Progress Mobile users before it is applied to projects. 

Resolution You can now edit any of the information on the Site Progress Mobile Approve 
Progress dialog that has been entered or changed by a Mobile user. For example, if 
a Mobile user has recorded an actual finish date for one of their tasks, you can 
change this date; if a Mobile user has updated the % complete for a task, you can 
change this percentage. If a Mobile user has not updated a particular field for a task, 
you cannot edit the field. For example, if a Mobile user has not updated the % 
complete for a task, you cannot change this percentage. 
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Issue 29266 Enterprise-specific  BIM-specific  

Summary Name the folders in which Site Progress Mobile photographs are stored after unique 
task IDs rather than internal task IDs. 

Description Before this release, the folders in which photographs that were taken by Site 
Progress Mobile users were stored were named after the internal ID of the 
associated tasks. This could make it difficult to identify the task to which a 
photograph related.  

Resolution If photographs are downloaded from the Cloud, they are now stored in a series of 
subfolders, each subfolder named after the project name, subproject name and 
unique task ID/task name. For example, if a photograph is attached to a 
Groundworks task with a unique task ID of ABC1 which is located in the Plot 1 
subproject of the Site A project, the photograph will be stored in a subfolder called 
\Site A – Plot 1\ABC1 – Groundworks\. The file name of each photograph is the date 
and time at which the photograph was taken. 

 

Issue 29360 Enterprise-specific  BIM-specific  

Summary Specify an override colour for ASAP force critical tasks. 

Description Before this release, tasks that were configured to be ASAP force critical – tasks 
positioned to start as soon as possible but with no free float so that they become 
critical – appeared identical to critical tasks. This made it difficult to differentiate 
between critical tasks and ASAP force critical tasks. A request was made for it to be 
possible to specify an override colour for ASAP force critical tasks, to make it easy to 
identify them in the bar chart. 

Resolution You can now specify an override colour for tasks that are configured to be ASAP 
force critical. To do this, use the ASAP force critical override colour field that has 
been added to the View tab of the Options dialog. If you specify an override colour 
in this field, all tasks that are configured to be ASAP force critical are given a critical 
appearance using the specified colour rather than the standard critical marking 
following a reschedule. 

 

Issue 29436 Enterprise-specific  BIM-specific  

Summary Identify jobs that may be consuming licences unnecessarily. 

Description Before this release, there was no way of identifying Site Progress Mobile jobs that 
have been exported, but that have not yet been updated by a Mobile user, using 
either a mobile device or a web browser. Such jobs may be consuming licences 
unnecessarily. 

Resolution Now, an “Exported not in use” status has been added to the Displaying jobs field, on 
the Site Progress Mobile tab of the Backstage view, which you can use to identify 
jobs that have been exported but not updated. This can help you to identify jobs 
that may be consuming licences unnecessarily; if a job has this status for some time, 
you may want to delete it to free up a licence. 
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Issue 29475 Enterprise-specific  BIM-specific  

Summary After assigning a code to a bar, the code is shown to be assigned to any selected 
tasks as well. 

Description Since the release of version 14.0.03, if you selected a task and viewed its properties 
– using either the Bar and Task Properties dialog or the properties view – then, on 
the Bar tab, assigned a code to the task’s bar, the Task tab mistakenly showed the 
code to be assigned to the selected task as well as to the bar, until the task was de-
selected. 

Resolution When codes are assigned to bars in this way, they no longer appear to be assigned 
to the selected task. 

 

Issue 29496 Enterprise-specific  BIM-specific  

Summary Add a message to inform you that a Site Progress Mobile export or import is taking 
place. 

Description Before this release, Powerproject gave no indication that an export or import of Site 
Progress Mobile data was taking place. This was not a problem if the export or 
import was small, but when large amounts of data were being exported or 
imported, it could appear that Powerproject had crashed. 

Resolution Now, an “Exporting Site Progress Data” or “Importing Site Progress Data” message 
appears when an export or import is taking place to reassure you that  has not 
crashed. The message disappears automatically when the export or import is 
complete. 

 

Issue 29545 Enterprise-specific  BIM-specific  

Summary Error when using Project Comparison with a customer’s project. 

Description Since the release of version 14.0.03, using Project Comparison with a customer’s 
project resulting in the following error: “Error HRESULT E_FAIL has returned from a 
call to a COM component”. 

Resolution This error was caused by a task having an amount of free float that was defined in 
terms of elapsed time, rather than working time; Project Comparison was unable to 
deal with this scenario. Project Comparison is now able to deal with scenarios such 
as this. 
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Issue 29610 Enterprise-specific  BIM-specific  

Summary Scale the font in text annotations and task notes when printing. 

Description Before this release, although you could scale text in legends and in the spreadsheet, 
you could not scale text annotations or task notes when printing. This could result in 
annotations and task notes looking too small in relation to the rest of the text in a 
printout. 

Resolution A new Scale bar chart fonts with spreadsheet check box has been added to the 
Appearance tab of the Print dialog. If you select this check box, text in annotations 
and task notes is scaled according to the scaling settings that you specify using the 
Font scaling group of fields on this dialog. 

 

Issue 29659 Enterprise-specific  BIM-specific  

Summary Open a project without opening the associated IFC model. 

Description A request was made for it to be possible to open projects in Powerproject BIM 
without their associated IFC models being opened automatically. 

Resolution A Disable IFC model loading check box has been added to the Open tab of the 
Backstage view. You can use this check box to open projects without opening their 
associated IFC models. Projects open more quickly when they are opened without 
their associated IFC models, so you may want to do this if you want to work with a 
Powerproject BIM project without the need to work with its associated IFC model. 

 

Issue 29704/29779 Enterprise-specific  BIM-specific  

Summary Make it easier to access the Site Progress Mobile Chart Assignments dialog. 

Description You use the Site Progress Mobile Chart Assignments dialog to associate users with 
the charts or summary groups within your Powerproject projects for which they are 
responsible. Before this release, to access this dialog for a number of projects you 
had to open each project in turn, then on the Project tab of the Ribbon, in the Site 
Progress Mobile group, click Chart Assignments. A request was made for it to be 
made easier to access this dialog. 

Resolution You can now associate users with charts or summary groups across a number of 
projects without having to open each project individually, using the new Chart 
Assignments button that has been added to the Site Progress Mobile tab of the 
Backstage view. Note that this button appears only when jobs that are ready to 
export are displayed. 

 
  



  15.0.01 Release Notes 

© 2019 Elecosoft  Page 15 of 24 

 

Issue 29706 Enterprise-specific  BIM-specific  

Summary Transfer Progress dialog now accessible via a new Ribbon control. 

Description Before this release, if you wanted to access the Transfer Progress dialog to copy the 
progress from one project to another, you had to customise the Ribbon to add the 
Transfer Progress control to it. A request was made for this command to be 
available on the Ribbon by default. 

Resolution The Transfer Progress control has now been added to the Ribbon – on the Home 
tab, in the Progress group. This means that you no longer need to customise the 
Ribbon to access the Transfer Progress dialog. 

 

Issue 29778 Enterprise-specific  BIM-specific  

Summary Make it possible to select all archived Site Progress Mobile jobs at the same time. 

Description Before this release, the Select All and Select None buttons on the Site Progress 
Mobile tab of the Backstage view were available only when jobs of particular 
statuses were selected. A request was made for it to be possible to select all 
archived Site Progress Mobile jobs in the jobs grid at the same time, so that it would 
be possible to delete all archived jobs in one step, rather than having to delete them 
individually. 

Resolution The Select All and Select None buttons are now available regardless of the type of 
job that is currently displayed in the jobs grid. This means that you can now change 
the status of, or delete, all the jobs in the jobs grid at once, without having to 
process each job individually, by selecting all jobs then right-clicking one of the jobs 
and selecting the action that you want to perform. For example, you can now 
display all archived jobs in the grid, select them all and delete them all at once. 

 

Issue 29920 Enterprise-specific  BIM-specific  

Summary Copy and paste selections while retaining links to and from tasks outside the 
selection. 

Description A request was made for it to be possible to copy and paste one or more bars or 
tasks, including links between the copied bars or tasks and tasks outside the 
selection. 
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Resolution A Paste and Retain Links command has been added to: 

• The Paste dropdown, on the Home tab of the Ribbon, in the Clipboard tab. 
• The bar chart right-click menu. 
• The spreadsheet right-click menu. 

Selecting this command will paste the selection of bars or tasks that have been 
copied to the Clipboard, including any links between these bars or tasks and tasks 
outside the selection. 

For example, if tasks A, B, C and D are linked together with Start-to-Finish links and 
you copy the bars containing tasks B and C to the Clipboard then select the new 
Paste and Retain Links command, copies of B and C are pasted into the bar chart, 
with a link from task A to the copy of task B, and a link from the copy of task C to 
task D. 

 

Issue 29968 Enterprise-specific  BIM-specific  

Summary Spreadsheet formulae are not evaluated correctly in ‘jagged progress’ views. 

Description Before this release, spreadsheet formulae were not evaluated correctly when a view 
was displayed in ‘jagged progress’ mode.  

Resolution Spreadsheet formulae are now evaluated correctly when a view is displayed in 
‘jagged progress’ mode. This means, for example, that you can now create a formula 
that displays a traffic light indicator for slip that will work when the view is in ‘jagged 
progress’ mode. 

 

Issue 29989 Enterprise-specific  BIM-specific  

Summary Remove progress from tasks according to the progress period in which it was 
reported. 

Description Before this release, a macro was available which enabled you to remove progress 
from tasks according to the progress period in which it was reported. A request was 
made for this macro to be integrated into Powerproject. 

Resolution A new Selectively Remove Progress control has been added. If you add this control 
to the Ribbon, you can use it to access the Selectively Remove Progress dialog, 
which you can use to remove progress from tasks according to the progress period 
in which it was reported. 

This control does not appear on the Ribbon by default; to use it, you must customise 
the Ribbon and add the control. 
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Issue 29990 Enterprise-specific  BIM-specific  

Summary Enhancements to the display of progress in the bar chart. 

Description A request was made for the following improvements to be made to the display of 
progress in the bar chart: 

• Override the colour of all progress lines in the bar chart with a single colour 
of your choice. 

• Override the colour of all progress shading on tasks and allocations with a 
single colour of your choice. 

• Display progress shading across the entire height of tasks and allocations, 
rather than just across the top half. 

Resolution Improvements have been made to the Progress tab of the Format Bar Chart dialog 
which enable you to do all these things. 

 

Issue 29991 Enterprise-specific  BIM-specific  

Summary Display progress lines and shading in the date zone. 

Description A request was made for it to be possible to display progress lines and shading in the 
date zone, as this would make the progress report date of each progress period 
more obvious when progress lines are displayed jagged rather than straight. 

Resolution You can now display progress lines and shading in the date zone, using the Display 
progress lines and Display progress shading check boxes that have been added to 
the General tab of the Date Zone Properties dialog. 

 

Issue 30040 Enterprise-specific  BIM-specific  

Summary Powerproject stops working if you choose to ignore all instances of a word when 
spell-checking. 

Description Since the release of version 14.0.01, Powerproject would stop working if you chose 
to ignore all instances of a word or abbreviation that includes punctuation (for 
example “etc.” or “i.e.”) when checking the spelling in a project. 

Resolution The fix for an earlier bug resulted in an infinite loop occurring in this situation. This 
issue has now been resolved. 
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Issue 30074 Enterprise-specific  BIM-specific  

Summary Deleting a histogram that obscures the bar chart makes the bar chart disappear. 

Description Before this release, if you enlarged the histogram pane so that it obscured the bar 
chart completely and reached all the way up to the bottom of the date zone, then 
deleted the histogram, the bar chart was not redisplayed. Instead, the date zone 
was enlarged so that it extended over the area that should have been taken up by 
the bar chart. 

Resolution Powerproject was unable to redisplay panes whose height had been reduced to zero 
as a result of other panes being enlarged. This issue has now been resolved. 

 

Issue 30082 Enterprise-specific  BIM-specific  

Summary Unable to view an IFC model from certain angles in the IFC Model pane. 

Description Before this release, a particular IFC model was visible only from certain angles when 
viewed in the IFC Model pane. 

Resolution The IFC file in question contained a circle arc with an invalid radius, which 
Powerproject BIM was unable to display. Powerproject BIM has been improved so 
that it now copes with such non-fitting curves. 

 

Issue 30098 Enterprise-specific  BIM-specific  

Summary The Print dialog’s Close button activates printing when the Picture file check box is 
selected. 

Description Before this release, if you selected the Picture file check box on the Output tab of 
the Print dialog then clicked Close – to close the dialog without printing – 
Powerproject would attempt to print to file. Clicking Close rather than Print should 
close the dialog without printing. 

Resolution Clicking Close in this situation now closes the Print dialog without attempting to 
print to file. 

 

Issue 30101 Enterprise-specific  BIM-specific  

Summary Unable to view an IFC model from certain angles in the IFC Model pane. 

Description Before this release, an unusually wide IFC model was visible only from certain angles 
when viewed in the IFC Model pane. 

Resolution Before this release, the IFC Model pane had a fixed view range with a maximum of 
two kilometres. Parts of this unusually large model that were outside this range 
were therefore not displayed in the IFC Model pane. Powerproject BIM now no 
longer has a fixed view range; instead, it defines a view range suitable for each IFC 
model as it is opened, which means that it can now display all parts of extremely 
large IFC models. 
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Issue 30113 Enterprise-specific  BIM-specific  

Summary Enable users to compare tasks’ original duration using Project Comparison. 

Description A request was made for it to be possible to compare the original duration of tasks 
using Project Comparison. 

Resolution A “Task original duration changes” report component has been added to Project 
Comparison. If you include this component in a project analysis report, the original 
duration of tasks is compared in the report. 

 

Issue 30135 Enterprise-specific  BIM-specific  

Summary Copy information from the Site Progress Mobile Approve Progress dialog to the 
Windows Clipboard. 

Description A request was made for it to be possible to copy information from the Site Progress 
Mobile Approve Progress dialog to the Windows Clipboard, so that it could then be 
pasted into an external application. 

Resolution You can now copy information from the Site Progress Mobile Approve Progress 
dialog to the Windows Clipboard, using the Copy to Clipboard button that has been 
added to the dialog. 

 

Issue 30152 Enterprise-specific  BIM-specific  

Summary Graph task work in histograms. 

Description Before this release, you were only able to graph resource and cost centre 
information in histograms. A request was made for it to be possible to graph task 
work in histograms. 

Resolution You can now graph task work in histograms. To do this, select “Task” in the 
histogram pane resource selector, and display a histogram report that includes the 
“AllocatedWork” generator, against which no resource has been specified. 

 

Issue 30183 Enterprise-specific  BIM-specific  

Summary Clearing a build stage’s check box in the Site Progress Mobile Ticksheet screen does 
not set the percentage progress of the build stage to zero. 

Description Before this release, if you cleared a build stage’s check box in the Site Progress 
Mobile Ticksheet screen, the percentage progress of the build stage displayed on 
the “slider” was not reset to zero. 

Resolution If you clear a build stage’s check box in the Site Progress Mobile Ticksheet screen, 
the percentage progress of the build stage displayed on the “slider” is now reset to 
zero. 
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Issue 30204 Enterprise-specific  BIM-specific  

Summary Powerproject BIM displays a rogue object in an IFC model which does not appear in 
other applications. 

Description Before this release, Powerproject BIM displayed an object in a particular IFC model 
which should not have appeared, and which did not appear in other applications. 

Resolution The IFC file in question contained an unbound CSG (constructive solid geometry) 
face, which Powerproject BIM was unable to handle. Powerproject BIM has been 
improved so that it now copes with such situations. 

 

Issue 30211 Enterprise-specific  BIM-specific  

Summary Create user-defined fields to store information about baselines. 

Description A request was made for it to be possible to store information in user-defined fields 
at baseline level, to make it easier to refer to baselines of particular types in reports. 

Resolution You can now store information in baseline-level user-defined fields. One possible 
use of this is to enter IDs against baselines that you can reference in reports. For 
example, if you have Contract, Delivery and Revised baselines, you could enter IDs 
to identify these into a baseline-level user-defined field, then reference these in 
reports. This is preferable to referencing baseline names in reports, as once a 
baseline has been created it cannot be renamed, and if a baseline has been named 
incorrectly, reports that reference the name as it should be will not work. 

Using a user-defined field to identify which baseline performs a particular role – 
Contract, Delivery, etc – also enables you to change which baseline performs each 
role, by editing the IDs that you have entered into the user-defined field. For 
example, you could identify that a different baseline performs the Contract baseline 
role by editing the user-defined field that identifies the role of a baseline and 
entering “Contract” into the field for the new Contract baseline. 

 

Issue 30229 Enterprise-specific  BIM-specific  

Summary New Planned actual task work and Planned task work remaining fields. 

Description A request was made for Planned actual task work and Planned task work remaining 
fields to be added to Powerproject. 

Resolution Planned actual task work and Planned task work remaining fields have been added 
to the Progress and Task Work groups of fields. 

The Planned actual task work field displays the number of task work units have been 
completed for each task in the specified baseline, by the specified report date. 

The Planned task work remaining field displays the number of task work units that 
have yet to be completed for each task in the specified baseline, by the specified 
report date. 

If no baseline is specified, these fields display the number of task work units that 
have been completed, or that have yet to be completed, in the live data. 
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Issue 30293 Enterprise-specific  BIM-specific  

Summary When copying a view to another project, histograms are excluded. 

Description Before this release, if you copied a view in which a histogram was displayed from 
one project to another, the histogram was not copied across with the view. 

Resolution If you copy a view in which a histogram is displayed to another project, the 
histogram is now copied with the view. 

 

Issue 30443 Enterprise-specific  BIM-specific  

Summary Simplify complex formulae using local variables. 

Description A request was made for it to be possible to simplify complex formulae. 

Resolution You can now simplify complex formulae by defining one or more “local variables” in 
your formulae. A local variable stores a part of a formula which can then be reused 
any number of times in the body of the formula, saving you from having to enter the 
information multiple times. A local variable comprises the word “Let”, the name of 
the variable, an equal sign and the expression, and is terminated with a semicolon. 

 

Issue 30480 Enterprise-specific  BIM-specific  

Summary Access right issue with annotations and task pools. 

Description Before this release, if a task pool containing an annotation was dragged into a 
project, users that belong to security groups with rights to view annotations – other 
than the Admin security group – were not able to view the annotation. 

Resolution Users that belong to security groups with rights to view annotations can now view 
annotations that originate in task pools. 

 

Issue 30525 Enterprise-specific  BIM-specific  

Summary Task work-related fields do not respect the option to show zeros as blank. 

Description Before this release, the task work-related fields did not respect the Zero as blank 
field, on the Table Definition Properties dialog. This meant that information was 
always displayed in these fields, regardless of whether the Zero as blank check box 
was selected. 

Resolution The task work-related fields now respect the Zero as blank check box. 
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Issue 30527 Enterprise-specific  BIM-specific  

Summary Spreadsheet cells display incorrect information. 

Description Before this release, if some child tasks had task work values and others did not, the 
Actual Planned Work and Planned Task Work fields displayed “0, value” against the 
owning parent task in the spreadsheet in cases where a work unit other than the 
default was used to record task work. This was caused by the default work unit 
being rolled up to summary/expanded task level even when no task work had been 
recorded using that unit. 

Resolution The default work unit is no longer rolled up to summary/expanded task level if no 
task work has been recorded using that unit. 

 

Issue 30569 Enterprise-specific  BIM-specific  

Summary Hammocks on the critical path cause reschedule problems. 

Description Before this release, if you rescheduled a chart that included a hammock on the 
critical path, float could be applied to tasks incorrectly, disrupting the critical path. 

Resolution This problem was caused by the reschedule routine failing to examine the contents 
of hammocks when calculating the finish date of tasks. The reschedule routine now 
examines the contents of hammocks that are included in the scope of the 
reschedule, which has resolved the problem. 

 

Issue 30576 Enterprise-specific  BIM-specific  

Summary Actual and constrained dates are not highlighted in the spreadsheet if the column is 
configured to display information about tasks with a particular code. 

Description Before this release, if you chose to highlight actual and constrained dates in the 
spreadsheet by selecting the Identify Start/Finish dates when ‘Actual’ or 
constrained check box on the Spreadsheet tab of the Options dialog, dates were 
not highlighted if the spreadsheet column was configured to display information 
about tasks with a particular code.  

Resolution Actual and constrained dates are now highlighted when spreadsheet columns are 
configured to display information about tasks with a particular code. 

 

Issue 30618 Enterprise-specific  BIM-specific  

Summary Draw the non-critical sections of part-critical tasks without a bold outline. 

Description Before this release, if you chose to display part-critical shading on tasks by selecting 
the Part-critical shading check box on the Schedule tab of the Format Bar Chart 
dialog, the non-critical sections of part-critical tasks were drawn with a bold outline. 

Resolution The non-critical sections of part-critical tasks are no longer drawn with a bold 
outline when part-critical shading is displayed on tasks. 
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Issue 30636 Enterprise-specific  BIM-specific  

Summary Remaining duration of tasks does not respect the snapping unit when progress is 
updated on a task that has task work. 

Description Before this release, if you updated the percentage progress on a task that has task 
work, the remaining duration of the task did not respect the chosen snapping unit. 
For example, if the snapping unit was set to Days, tasks could end up with remaining 
durations such as 4.6d or 5.3d. 

Resolution The task work rate is now adjusted when progress is updated on a task that has task 
work, so that remaining duration respects the snapping unit.  

 

Issue 30637 Enterprise-specific  BIM-specific  

Summary Progress line appears jagged on summary tasks when it should be straight when 
coloured progress is displayed. 

Description Before this release, if you displayed coloured progress on the bar chart, the progress 
line appeared jagged on summary tasks in which gaps existed between tasks in the 
summary group, when it should have appeared straight.  

Resolution The progress line now appears correctly on summary tasks in which gaps existed 
between tasks in the summary group, regardless of whether coloured progress is 
displayed. 

 

Issue 30685 Enterprise-specific  BIM-specific  

Summary Reschedule gives incorrect results when a milestone appears just after a completed 
task or milestone on the same bar. 

Description Before this release, the reschedule routine failed to reschedule milestones correctly 
if they appeared just after a completed task or milestone on the same bar. This was 
caused by Powerproject failing to place an implied link between the completed task 
or milestone and the following milestone on the same bar. 

Resolution Powerproject now places implied links between completed tasks or milestones and 
following milestones on the same bar, which results in the reschedule routine giving 
correct results in this situation. 

 

Issue 30880 Enterprise-specific  BIM-specific  

Summary Group tasks by chart and summary group when approving Site Progress Mobile 
progress. 

Description A request was made for the tasks on the Site Progress Mobile Approve Progress 
dialog to be grouped by chart and summary group, to make it easier to identify each 
task’s location in a project. 

Resolution The tasks on the Site Progress Mobile Approve Progress dialog are now grouped by 
chart and summary group. 
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Issue 30936 Enterprise-specific  BIM-specific  

Summary Cannot copy and paste information from spreadsheet cells that display the ‘IFC 
simulation profile’ field. 

Description Before this release, it was not possible to copy and paste information from 
spreadsheet cells that displayed the ‘IFC simulation profile’ field. 

Resolution It is now possible to copy and paste information from spreadsheet cells that display 
the ‘IFC simulation profile’ field. 

 

Issue 30986 Enterprise-specific  BIM-specific  

Summary No date appears against milestones in the Actual start and Actual finish columns. 

Description Before this release, no date was displayed against milestones in the Actual start and 
Actual finish columns, if the columns were configured to display information relating 
to the progress entry period. 

Resolution The Actual start and Actual finish columns now display dates for milestones when 
they are configured to display information relating to the progress entry period. 
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